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Lake County Area Computer Enthusiasts 

The L.C.A.C.E. News Journal is published eleven times 
annually. Members are encouraged to submit 
contributions and will be acknowledged in this newsletter. 
 
Permission is granted to reproduce any or all parts of this 
newsletter in other User Group publications, provided that 
credit is given to L.C.A.C.E. and the individual author(s).  
 
The News Journal is produced using a Dell Dimension 
4100 Computer, Lexmark X83 scanner using MS 
Publisher 2002 software. Graphics editing and artwork 
provided by Pegasus Enterprises. Photos taken w/
Olympus D-400 Zoom Photo PC digital camera. 
Printing is done on an Epson Stylus Color 880 Printer, 
and Adobe Acrobat for PDF conversion. 

Lake County Area Computer Enthusiasts 
L.C.A.C.E.  

c/o Group Ambassador 
409 S. Elmwood Ave. 

Waukegan, Illinois 60085-5219 
 

Membership 
 

Membership for L.C.A.C.E is open to all individuals 
and families interested in personal computing. Annual 
dues are $20.00 per individual/family. Associate 
membership is only $10.00 (out of state, unable to 
attend meetings). Membership includes a one year 
subscription to the L.C.A.C.E. News Journal and ac-
cess to all club libraries and functions. Applications 
for membership may be obtained at the monthly 
meeting, by request on the club Hotline and are now 
available on our WEB site at  - http://www.lcace.org 
 

Meetings 
 

L.C.A.C.E. meetings are held on the second Saturday 
of each month at the Grayslake Area Public Library 
100 Library Lane, Grayslake, Illinois. The meeting 
location opens at 12:00 a.m.,  the formal meeting be-
gins at 12:30p.m.  All meetings are open to the pub-
lic.  Bring a friend! 
 

Advertising 
 

Ad rates per issue: Full page - $25, Half page - $15, 
Quarter page - $10, Business Card - $5. Discounts are 
available on advance purchase of multiple issues. 
Please send camera-ready copy and payment to the 
club address by the 21st of the month preceding pub-
lication. For more information on ad pricing, please 
call our Hotline. Ads are FREE to all paid members.  

Notice 
 

L.C.A.C.E  WILL NOT CONDONE  or knowingly 
participate in copyright infringement of  any kind. 
The L.C.A.C.E. News Journal is published by and for 
L.C.A.C.E. members. Opinions expressed herein are 
those of the individual authors and do not necessarily 
reflect the opinion of L.C.A.C.E., the membership, 
the Board of Directors, and/or our advertisers. 
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www.ccxpo.com 
All L.C.A.C.E. Members who present their membership card will receive a $1 discount. 

Save up to 70%  FREE Parking  

Great prices! Bargains galore!  
October 6, 2002 

9:30 am - 3:30 pm 
$6 Admission 

Gurnee Holiday Inn 
Main Ballroom 

6161 W. Grand Avenue  
Gurnee, Illinois 60031 

WebWatch 
WebAttack.com - Bad name, excellent source of inter-
net utilities. Includes helpful tips and tricks, plus visual 
demonstration of software. www.webattack.com 
 
Version Tracker – Up-to-date shareware utilities driv-
ers, software upgrades, and more. It’s easy to find 
things at this fairly fast site. www.versiontracker.com 
 
Tucows – This site has become more cluttered lately, 
but its still a must-visit for anyone looking for commer-
cial and free downloads. www.tucows.com 
 
FindSounds – Part search engine, part download tool, 
this site is ideal for locating and obtaining all sorts of 
sound files for the Web. www.findsound.com 

Vital records can now be purchased on Net 
Vital records maintained by Lake County Clerk Willard 
Helander’s office are not available for purchase on the 
Internet with credit card billing. 
Previously, birth, marriage and death records could be 
requested in person or by fax but now these records can 
be ordered via the clerks’ Web site @  
www.co.lake.il.us/cntyclk for added convenience. 

Certified records requested in person are $8. Certified 
records requested via fax or online have an additional 
charge added for overnight mail. For more information 
on requesting records in person, by fax or online, call 
the clerk’s office @ 847.337.2400. 

From the Editor 
 Due to circumstances beyond my control I want 
to apologize for not having the News Journal out on 
time.  I have to give J.J. a special thanks for supplying 
the articles.  If it wasn’t for his help there wouldn’t be a 
Journal this month.  Again Thanks J.J. 
 
  Well fall is here and it’s almost time for the Holiday 
Party.  Tickets for the raffle will be available at this 
months CCxpo as well as the regular meeting.  Your 
help is selling the raffle tickets will benefit the club. 
 
  If anyone has any ideas for future demos or for any 
club activity, please let anyone of the Board members 
know.  This is your club and with your input, we will 
know what direction to take the club. 
             Mike 

Product Support Tip of the Month  
 Question: What do you do when your Micro-
soft® Outlook® Express mail folders, e-mail 
messages, and Address Book are missing after 
you upgrade to the Microsoft Windows® XP op-

Continued on page 6 
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HARDWARE REVIEW 
ARCHOS Jukebox Recorder 15 
Play, record, and store digital media on a portable 
15GB hard drive. I can carry my entire CD collection 
with me anywhere. 
By: Sammy Johnson 
 
MP3 players ROCK.  This is one piece of technology 
that has improved my life. It's amazing that a small 
chunk of plastic can play my favorite songs as my pur-
sue your favorite physical activities(walking), without 
skipping!  
 
I’ve tried other MP3 players capable of providing about 
1 hour of nonstop music, 
but the new Archos Juke-
box Recorder 15  goes 
way beyond the 1 hour 
barrier.  So far beyond, 
that I forget which songs 
are even on the unit.  At 
this writing, I have more 
than 10 albums and with 
more than 1500 “Oldies 
But Goodies”  stored on 
the Jukebox Re-
corder.  That's 8GB - and 
there's still 7 GB of free 
disk space left! 
A recent trip Ohio forced 
me to endure more than 6 
hours of driving time, but 
with the Jukebox Re-
corder, I never heard the 
same song twice!  The 
miniature hard drive 
weighs in at 12.3 ounces, and is heftier than competitive 
memory-only units.  The Jukebox Recorder isn't ideally 
suited to extreme activities such as running or mountain 
biking, but for general travel use, this little devil is 
worth its weight. 
 
The Jukebox Recorder is supplied with two sets of re-
chargeable batteries, which last about 10 hours per 
charge.  Also included are a set of above-average quality 
behind-the-head foldable headphones, AC power 
adapter/charger, portable carrying case, the excellent 

MusicMatch Jukebox software, and an operating man-
ual. Since I already had MusicMatch 7.1 on my com-
puter all I need was to load the drivers. 
 
From Vinyl to MP3 
Loading MP3's onto the Jukebox Recorder is as simple 
as plugging in the supplied USB 1.1 cable and dragging 
and dropping the files into the Jukebox Recorder.  On 
my Windows XP laptop, the Jukebox Recorder showed 
up as a regular 15GB drive.  There's no reason to only 
stick with MP3's, as the unit will easily transport any 
files you want to store.  Take the Jukebox Recorder to 
work, load it up with all of those MP3's you downloaded 
on your broadband connection, then transfer the files to 
your home computer.  An average 12 song (48MB) al-
bum transfer takes less than 30 seconds. 

 
But the most exciting feature 
of the Jukebox Recorder is 
that you can copy your vinyl 
recordings directly into the 
unit.  Plug the supplied RCA 
cable into your stereo, set the 
Jukebox Recorder to 
"record," and start the al-
bum.  You must record the 
album in "real time," but I 
had no difficulties converting 
two of my favorite records to 
MP3 format.  You may select 
various recording qualities, 
from 30 to 160Kbps.  It was 
odd to hear the occasional 
"pop" of the needle, but 
popular software such as 
SoundForge is capable of 
splitting and editing your 
digital audio files.  After re-

cording an album, it is very simple to transfer the data to 
your desktop computer to burn CD's. 
The Jukebox Recorder supports analog, microphone, 
and digital recording formats. 
 
Traveling with the Jukebox Recorder  
The Jukebox Recorder has no integral belt -clip, so I slid 
the Jukebox Recorder into the soft carrying case and 
attached it to my belt.  The unit felt a bit unsecured, as it 
bobbed around a bit. The 1.25" x 1" backlit green and 
black LCD screen provides all ID3 tag informa-
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tion.  Volume is controlled via a knob on the supplied 
headphones or via a somewhat cumbersome bit of but-
ton pushing on the Jukebox Recorder itself.  A wide 
range of tonal variations may be set, including bass, 
treble, loudness, balance, and bass boost.  Unfortu-
nately, these settings are not remembered for specific 
types of music.  Still, the Jukebox Recorder offers more 
tonal flexibility than most portables. 
My first test of the unit involved going for a short 
walk.  While the included headphones are adequate and 
provide volume control, I preferred my own head-
phones.  Unfortunately, changing the volume on the 
Jukebox Recorder requires 3 clicks on the front panel, 
which  is still a little difficult to manage while walk-
ing.  Walking proved to be no problem. The 2MB of 
onboard buffer memory was sufficient, and the unit 
never skipped in several hours of use.  Abundant use of 
rubber protects the Jukebox Recorder from the odd 
bump.  I didn't risk test-dropping my unit, but my guess 
is that a small drop wouldn't damage the drive. 
I've yet to find a portable music player that levels the 
audio volume (called compression).  The Jukebox Re-
corder is no exception, and the various volume levels of 
MP3's has you reaching for the volume more than you'd 
like. 
The play list menu is easy to navigate, and songs may 
be stored in play list format, regular folders, or hodge-
podge on the drive.  Simply select a folder, select the 
first song, and the music begins.  There are also options 
for repeating and shuffling your files, as well as queuing 
and scanning. 
One annoyance is that there is a noticeable bleed-
through of hard-drive noise into the audio portion of the 
Jukebox Recorder.  While I couldn't hear this noise in 
the car or walking near traffic, the noise was noticeable 
in quiet areas. 
 
Final Thoughts 
The Jukebox Recorder succeeds very well at playing 
hours and hours of music.  Recording analog record al-
bums is a joy.  The portable hard-drive capability is also 
a plus.  But the lack of buffer memory is an issue, and if 
you are thinking about purchasing a unit for running or 
other sports, stick with a memory-only unit for now.  If 
you are looking for mega-capacity for both office and 
travel use, the Jukebox Recorder is a winner.  Next time 
you travel from Los Angeles to Hong Kong, take the 
Jukebox Recorder with you and listen to your entire col-
lection of LP's and CD's!  

 
Archos makes  the Jukebox with a 6, 10, 15 and 20GB 
hard drive. Merge your entire collection of MP3s and 
CDs (150, 250, 375 or 500 audio CD’s: 1500, 2500 
3750, 5000 songs) into your pocket, and listen to all 
your favorite music to go.  
 
Street price of the Jukebox 15GB $189 - $229 
 
Archos Technology Inc. 
3-A Goodyear 
Irvine, CA 92618 
Phone: (949) 609-1400 
Fax: (949) 609-1414 
www.archos.com 

Patches and Add-ins   
       
 

 Windows XP Patch  
If the 3-D Flowerbox, 3-D Flying Objects, 3-D 
Pipes, 3-D Text, or another Direct3D®-based 
screen saver is running in Microsoft® Windows® 
XP, the computer may be unable to enter 
standby or hibernation by using the timer in 
Power Management properties. Download the 
patch now to avoid this issue at: 
http://www.microsoft.com/downloads/ 
 
  
 Look for the following downloads at: 
http://www.office.microsoft.com/downloads 
 

 Office XP Add-in: Microsoft Visual 
Keyboard  
Are you bi-lingual? Do you want to type in more 
than one language on the same computer? This 
add-in shows you a keyboard for another lan-
guage on your screen.  
 

 Excel 2002 Add-in: Access Links 
While working in Microsoft® Excel 2002 and Mi-
crosoft Access 2002, you can use several Access 
features to maintain your Excel data with the Ac-
cess Links add-in program. Note: Although it was 
not necessary to download this add-in with pre-
vious versions of Excel (it was shipped with the 
product), you must download it to use it with Ex-
cel 2002.  
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erating system.  
 
 Answer: It’s as easy A-B-C-D… E-Mail!  
 
 This behavior occurs because the Windows XP 
file structure is different and the files for Outlook 
Express are no longer in the same location. This 
five-step procedure will help you find your previ-
ous mail, folders, and Address Book, and import 
them back into Outlook Express.  
A. Find Your Previous Mail Messages: 
On your desktop, create a new folder called 
XPMail. To do this, right-click your desktop, click 
New, and then click Folder. If you use identi-
ties, create a new folder for each identity.  
Click Start, then click Search.  
In the What do you want to search for box, 
click All files and folders.  
In the All or part of the file name type *.dbx.  
Click More Advanced options, click Search 
hidden files and folders, then click Search. 
NOTE: If you had previously used identities, 
each user has their own identity folder. Each 
identity folder has a unique alphanumeric num-
ber (for example, {9EFEBDEA-CE00-4DD7-
A4D6-CDB85C3EEDBF}) followed by 
"\Microsoft\Outlook Express". 
You can differentiate between the previous iden-
tity and the new identity even though they may 
share the same alphanumeric number. The new 
identity will be followed by "\Microsoft\Outlook 
Ex". 
 B. Copy the Mail Folders  
Before you copy the mail folders from the previ-
ous identity folder to the new folder on the desk-
top called XPMail, please review the Note about 
differentiating between old and new identities in 
step 5 of the "Finding Your Previous Mail Mes-
sages" section.  
In the Search window, you may select each .dbx 
folder individually or select multiple folders by 
pressing the CTRL key and clicking each folder.  
After you have selected the folders, click Copy 
on the Edit menu.  

Open the XPMail folder, then click Paste on 
the Edit menu. 
 
NOTE: Make sure to include the Folders.dbx 
file when you copy the folders. This file is 
necessary for the import functions in Outlook 
Express. 

 This procedure copies all the files from the se-
lected folder into the XPMail folder. Perform this 
procedure for each identity folder, but make sure 
to create a separate folder, such as XPMail1, for 
each identity folder found.  
 C. Import Your Mail and Folders 
Open Outlook Express.  
On the File menu, click Import.  
Click Messages.  
Click Microsoft Outlook Express 5, then click 
Next. 
NOTE: In some instances you may only see the 
options to import Outlook Express 4.0 and Outlook 
Express 6.0. If your previous version of Outlook 
Express was version 4.0, use the option for Out-
look Express 4.0. If you are importing from Out-
look Express 5.0, or 5.5, you can use the Outlook 
Express 6.0 option.  
Click Import mail from an Outlook Express 
6.0 store directory, then click OK.  
Click Browse, select the XPMail folder that you 
created earlier, click OK, then click Next.  

Click All folders, then click Next. 
 This procedure imports your previous mail into 
the current Identity. After it is finished, click Fin-
ish. Repeat this procedure for each of the folders 
that you created earlier.  
 D.  Find Your Windows Address Book 
Click Start, then click Search.  
Click All files and folders.  
In the What do you want to search for box, 
click All files and folders.  
In the All or part of the file name, type *.wab, 
then click Search.  
When the search is finished, double-click each file 
to open it. When you have found the correct one 
(it will contain your Contact information), note the 
exact location and name of the file. 
E. Import Your Windows Address Book 
In Outlook Express, click the File menu.  
Click Import, then click Address Book.  
Point the Look In field to the location that you 
noted in step #5 of the "Find Your Windows Ad-
dress Book" section.  
Click the .wab file, then click Open.  

Click OK to import the Address Book. 
 

 After you have verified that the import was 
successful, remove all folders that you cre-
ated during the mail recovery process.  
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Members 
Ruth Donahue-Allisonr            allison98@juno.com   
Jim Ashworth                  Blue_unicorn@netzero.com  
William & Diane Brumbachb       brumbach@cs.com  
Linda Busch                           lindashrub@juno.com  
Bob Carpenter               cubs14@ripon.alumlink.com  
Tom Fitzsimmons             tomfitzsimmons@juno.com  
Jack Frost                                  jfrost@megsinet.net 
Richard Graling                                     mtndew@mc.net 
Mr.  G                                           mrG3165@aol.com  
Phil Grimm                                 pgrimm4@attbi.com  
Arnie Gudyka                           arngood1@juno.com  
Terri Hanlon                               Terhanlon@aol.com  
Henry Henriksen                     bruisarandziggy@aol.com 
Marshia Hobson           marsgraphics@netscape.net 
Dwight (J.J.) Johnson                jj1450xl@ix.netcom.com 
Donna Kalinoski                 donnaleek@juno.com 
Steve Kostelnik                       steve_kostelnik@usa.net 
Lester Larkin                              LesLarkin@NetZero.net  
John Lawless                                                jay@iwc.net  
Mark McDonald                    markym36@aol.com  
Mike McEnery                      mmcenery@core.com 
John Nabors                                           jog@nomad.net  
Lee Nordstrom                        LeeNord@mw.sisna.com 
Marcia Rose                       Mrose74801@aol.com  
James Rutledge                         jrutnet1@home.com  
Leslie Salsburg                          leslie164@juno.com  
Paul Schintgen                               paulj@theramp.net  
Walter Sheets                      eddoc85@netzero.net 
Gerald Straw                      ilotgks@concentric.net 
Grace Vogt                        gracemvogt@msn.com  
Steve Yeaton                           hiflyer9@bigfoot.com  

As much as we try, we do make errors. Please 
advise us if there is a mistake in your E-Mail ad-
dress or if it is not included in this listing.  Send 
E-Mail to editor@lcace.org with the additions 
and/or corrections. Thank you. This listing last up-
dated – April 1, 2002 

L.C.A.C.E. HOTLINE 
Call: 847-623-3815  

or  
fax: 877-349-4080 

 Web Site:  http://www.angelfire.com/clone/
lcace/index.htm 

Member’s Web Sites 

If you have a 
Web Site 

And would like to  
Advertise it here 

E-mail Me 
editor@lcace.org 

TIME TO RENEW 
 
If it is time for you to renew your membership, 
please fill out a new Application and a Member’s 
Profile Sheet. These forms can be obtained at the 
meetings or downloaded from our WEB site. 

Your Advertisement 
Should 

have been placed here. 
 
 

L.C.A.C.E. 
c/o Group Ambassador 
409 S. Elmwood Ave. 

Waukegan, Illinois 60085-5219 

See the CLUB PICURES at: 
 

 

 
 
 

Take a good 
look, you just 

might see 
yourself. 

www.picturetrail.com/lcace  



 

Next Meeting 
 

October 12, 2002 
 

Grayslake Public Library 
1200—3:00pm 

 
Meeting Room Opens 1200 

General Meeting Starts 12:30 
 

This month: 
 

L.C.A.C.E. Round-Table 
Beginners Sig. 

Printing & Mailing by L.C.A.C.E., Lake County, IL 

L.C.A.C.E 
Lake County Area Compuer Enthusiasts 
409 Elmwood S. Ave. 
Waukegan, IL 60085-5215 

ADDRESS CORRECTION REQUESTED 

L.C.A.C.E Online 
View our Site 
http://www.lcace.org 

 

E-Mail Us At: 
Web-master 

 
webmaster@lcace.org 

 
Sign the Guest Book and tell us what you think 
♦ LCACE E-mail addresses 
♦ LCACE information  
♦ LCACE history and pictures 
♦ LCACE meeting, location and map 
♦ LCACE members  e-mail addresses 
♦ LCACE online membership application 


